
La mayoría de los objetos en 3D presentan superficies suaves y sin imper fecciones, lo
que los hace demasiado perfectos para determinados contextos. El procedimiento
usual para conseguir una superficie con algo de rugosidad consiste en aplicar defor-
maciones usando los llamados Bump Maps (mapas de protuberencias). De hecho, el
Bump Map no es una característica de la propia superficie, sino una característica de la
cámara. En la mayoría de los casos la aplicación de Bump Maps es suficiente y repre-
senta una solución muy económica en términos de tiempo de representación. Sin
embargo, falla cuando se necesitan deformaciones muy pronunciadas y abultamien-
tos que contrasten fuertemente con el fondo.

Entramos en lo que se denomina Displacement Mapping —una técnica que no
imita las deformaciones de la cámara,sino que deforma realmente la superficie usan-
do las distintas tonalidades de gris de una textura procesada o una imagen—.Por des-
gracia,estas deformaciones no se pueden examinar en las vista de modelado. Es nece-
sario representarlas previamente.

Este ejercicio consta de dos partes que encajan perfectamente.
Comenzaremos usando superficies de división para modelar un hom-
bre alto y delgado con una pequeña cabeza. Con un poco de práctica,
esta tarea no debe llevar más de unos pocos minutos. (Antes de la
aparición de las subdivisiones, tareas de este tipo podían requerir
incuso horas.) Si no dispone de Maya Unlimited, puede conseguir
resultados similares usando las mismas herramientas de división y
extrusión y aplicando la operación Polygons>Smooth al final del
proceso. Si desea omitir la parte del modelado y dejarla para más ade-
lante, puede usar cualquier tipo de primitiva y continuar con la parte
del ejercicio relativa al desplazamiento.

1 Cree un cubo poligonal.
2 Elija Modify>Convert>Polygons to Subdiv, para convertir el
cubo en una superficie de división.
3 Asigne un nuevo material al cubo de subdivisión.
Si ha texturizado accidentalmente el cubo (que en realidad es sólo la
piel exterior de la superficie de subdivisión en lugar de la propia
superficie) en lugar de la superficie de subdivisión,deshaga la asigna-
ción. Seleccione la superficie de subdivisión polyToSubdShape1(por
ejemplo, en el Hypergraph) antes de asignar de nuevo el material.

Para las acciones que siguen,haga clic con el botón derecho en el objeto de subdivi-
sión y utilice el menú contextual.

4 Cambie al modo Polygon (véase la Figura 10.1).
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¿Cómo se construye una figura cuya superficie
presente más protuberancias que los personajes
en 3D habituales?
Tema: modelado, representación.
Técnicas y herramientas utilizadas: Subdivision
Surfaces, Split Polygon Tool, Extrude Faces,
Displacement Shader.
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Figura 10.1 Cubo poligonal convertido   ❍

en una superficie de subdivisión.
Su menú contextual permite hacer

visible el polígono original.

▲



Existen dos modos generales de modelado con superficies de subdivisión. Uno
consiste en usar las herramientas de polígono, y el otro en utilizar las herramientas del
mundo del modelado de Nurbs. Las herramientas clásicas de modelado de polígonos
son ideales para conseguir una resolución geométrica más alta (por ejemplo, en la
zona donde las piernas salen del torso).Ésta es la razón por la que realizaremos la ma-
yoría del modelado de nuestro personaje en el modo Polygon.

1 Elija Edit Polygons>Split Polygon Tool para dividir en dos la cara inferior del cubo
(véase la Figura 10.2).Hágalo a ojo, sin preocuparse por observar una precisión elevada
—nuestro personaje no va a participar en un concurso de belleza—. Termine el
comando Split pulsando Intro.
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▲ Figura 10.2 Utilice la herramienta Split
Polygon para dividir la cara inferior del
cubo en dos partes.

▲ Figura 10.4 Unas cuantas extrusiones
más tarde, las piernas están acabadas; no
son muy perfectas, pero son unas piernas.
Las últimas extrusiones (las horizontales, en
este caso), han dado lugar a los pies.

▲ Figura 10.3 La herramienta Extrude crea
una densidad geométrica local superior.
Aquí usaremos esta densidad superior para
comenzar a estirar caras y modelar las
piernas.

▲ Figura 10.5 Cambie a la vista lateral
para modelar con más precisión los
extremos de los pies.

▲ Figura 10.6 Ya están terminadas las
extremidades inferiores: con algo de
práctica, toda esta operación puede
realizarse en un par de minutos.



2 Utilice el menú contextual para hacer
fisibles las Faces. Seleccione las dos nue-
vas caras inferiores del cubo que ha crea-
do. Elija Edit Polygons>Extrude Face
para estirar la nueva geometría de estas
caras (véase la Figura 10.3). Al pulsar en
uno de los cubos de escalado de la herra-
mienta,ésta pasa el modo escala. Reduz-
ca un poco las superficies extruidas de
forma homogénea. Utilice la flecha de la
herramienta para trasladarlas un poco
hacia abajo.
3 No cambie la selección,pulse la tecla
G para aplicar de nuevo el comando de
extrusión, en esta ocasión a las nuevas
caras extruidas. Tire del torso para crear
las piernas aplicando el comando dos o
tres veces más. Con la última extrusión,
cree caras de un tamaño que pueda
usarse para sacar los pies hacia adelante
(véase la Figura 10.4).
4 Al extruir y escalar los pies, utilice las
vistas lateral y superior con el fin de tra-
bajar con más precisión.

1 Utilice la herramienta Split Polygon
en los lados del torso y comience a
extruir los brazos (y si lo desea,también
los dedos).El comando de extrusión ope-
ra simétricamente, por lo que podrá
extruir simultáneamente la geometría de
los brazos izquierdo y derecho (véase la
Figura 10.7).
2 Ext ru ya la ca ra supe rior del po l í g o n o
de subd i v i s ó n , re d u zca la escala de la
sección tra n s versal del cuello y co m i e n-
ce a tirar para sacar la ca beza (véase la
Fi g u ra 10.8).
3 Compruebe la figura en su conjunto, y
ajuste las caras a su gusto. Tenga presen-
te que no ha de limitarse a trasladar y
escalar, pudiendo también rotar caras
(véase la Figura 10.9).

En el Channel Box puede ver que,
después de realizar todas las extrusiones,
el historial de la construcción de la super-

50 Modelado

▲ Figura 10.7 Trabajando en la parte
superior del cuerpo: éstas son las dos

primeras extrusiones de los brazos.

▲ Figura 10.9 Resultado: rotación de la
parte de atrás de la cabeza.

▲ Figura 10.8 Las dos primeras extrusiones
para el cuello y la cabeza.

▲ Figura 10.10 El menú contextual de la
superficie de subdivisión permite cambiar
entre distintos niveles de la jerarquía.Los

niveles más refinados permiten trabajar de
forma más local.



ficie contiene una gran cantidad de información que no vamos a necesitar en el futu-
ro. Si borra el historial con el comando Edit>Delete by Type>History, de paso aclara-
rá algo la escena.

Lo que n o se pierde al bo rrar el histo rial de la supe rficie es su identidad co m o
s u pe rficie de división. Usando el menú co ntextual y los comandos Co a r s e r y Fi n e r,
puede cambiar de un nivel de la jera rquía al siguiente para poder trabajar de menera
más global o loca l ,t a nto en el modo poligonal como en el modo estándar (véase la
Fi g u ra 10.10).

No es necesario que añada mucho detalle al individuo en este momento,como una
nariz,los omópla tos o los dedos de los pies. De todas formas, el Displacement Shader
podría ocultar características del tamaño de una nariz o un omóplato.

1 En el Attribute Editor del grupo de sombreado de la superficie (en el caso de un
sombreador Blinn,su nombre sería blinn1SG),haga clic en el icono de damero que hay
junto a Displacement Mat.
2 Se abrirá la ventana Create Render Node (véase la Figura 10.11).Elija aquí la textu-
ra que deformará el personaje según sus valores de gris, como Solid Fractal. Seleccio-
ne As Projection como método de asignación.La proyección garantiza que la textura
se distribuirá de manera uniforme sobre todo el objeto.
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Figura 10.11 Aquí se muestra cómo crear
un Displacement Map de una textura en 3D
mediante una proyección: abra el Attribute
Editor del Shading Group,haga clic en el
icono de damero que hay junto a
Displacemant Mat., y elija “As projection”
en la ventana Create Render Node como
método, seleccionando, por ejemplo, Solid
Fractal como estructura.



● Ya que no podrá ver por ahora ningún cambio en la vista del modelo, represente la
escena.

La representación tardará algo de tiempo en completarse, tal vez varios minutos,
dependiendo de la geometría y el material utilizado y,naturalmente, de la velocidad de
la computadora. Los resultados ponen de manifiesto claramente la diferencia entre
Displacement Mapping y Bump Mapping. En la Figura 10.12,el personaje que apa-
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Figura 10.12 Estos dos personajes poseen la misma    ❍

geometría y la misma textura; la única diferencia está en la
forma en que se ha aplicado la textura. La uniformadidad de
la figura que aparece en primer plano proviene de un Bump

Map, mientras que la textura de la figura que aparece en
segundo plano se debe a un Displacement Map. Los bordes de
la figura de primer plano aparecen suaves,a diferencia de los

que presenta el otro personaje. Aunque no se ha aplicado
ningún ajuste especial al procedimiento de asignación,el

Displacement Map ha engordado dramáticamente al
personaje,mientras que la figura que tiene aplicado el mapa

de protuberancias conserva su tamaño original
de la geometría modelada.

Figura 10.14 El objeto de colocación   ❍

en 3D cubre ahora todo el personaje.A la
izquierda puede ver la escena representada.

Con el icono marcado puede guardar en
memoria imágenes representadas.Éstas no

se borrarán hasta que salga de Maya (o se
produzca un fallo en el programa).

▲ Figura 10.13 El cubo de líneas de dibujo
que hay en los pies del personaje
determinan las dimensiones del
Displacement Map. Cuanto menor sea el
cubo, con más frecuencia se repetirá la
textura en el objeto.
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rece en primer plano tiene aplicada la misma textura Solid
Fractal que el que aparece en segundo plano, pero dicha
textura fue asignada como Bump Map en lugar de como
Displacement Map (como es el caso del personaje del fon-
do). La superficie de la figura muestra rugosidades, pero sus
bordes aparecen totalmente lisos sobre el fondo, en con-
traste con los del personaje de atrás.

El Di s p l a ce m e nt Ma p p i n g tiene un efe cto mayor o
menor en función del tamaño de la figura . Hay dos fo rm a s
de ajustar la fuerza del efe cto. Una co n s i s te en cambiar la
densidad con la que la text u ra se asigna a la geometría. En las
vistas de mod e l a d o, puede ver un cubo de líneas de dibujo
llamado p l a ce 3 d T Ext u re 1;ésta es la herra m i e nta que pe rm i-
te realizar este tipo de cambios (véase la Fi g u ra 10.13).

La segunda forma de ajustar la textura de desplaza-
miento pasa por usar los valores de gris de la textura. El
Displacement Mapping, al igual que el Bump Map-
ping, utiliza sólo los brillos (el canal alpha y no el color)
de una textura para crear deformaciones geométricas.
Para la ma yoría de las texturas, como ocurre con Solid
Fractal, encontrará las entradas de escala de grises en el
apartado Color Balance del Attribute Editor. Empiece
con una tonalidad oscura,con valores casi negros para los
colores y un valor muy bajo para Alpha Gain (véase la Figu-
ra 10.15).

Básicamente, el personaje aumentará de tamaño si se le apli-
ca una textura brillante. Un Displacement Map que encuentre
únicamente el color negro en la textura,dejaría la figura sin cambios.

Figura 10.15 El Attribute Editor de la textura. En la parte
superior están los parámetros que controlan la estructura del
fractal y más abajo los parámetros relativos a las tonalidades
de gris, que son responsables de la cantidad de
deformación. Los parámetros más
importantes relacionados con un
Displacement Map son Color Gain
y Alpha Gain. Los valores más
altos dan lugar a más blanco,
lo que a su vez conduce a
figuras más grandes.
Cuando el Displacement
Map encuentra sólo
negro,deja la geometría
sin cambios.

Figura 10.16 Un
personaje que parece
esculpido en arcilla.
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Si la textura presenta zonas de alternancias de brillo, el
personaje aparecerá con muchos abultamientos, corres-
pondiéndose las áreas brillantes de la textura con los
salientes de la superficie.

No tendrá más remedio que realizar distintas prue-
bas hasta hallar una combinación correcta que le per-
mita conseguir el resultado que tenga en mente.Por des-
gracia, IPR no funciona con Displacement Map , lo que

significa que tendrá que sufrir las cor respondientes espe-
ras de las distintas fases de representación. Utilice la op-
ción de la ventana de representación para representar a
un tamaño menor, o sólo partes de la figura.
Con el modelado con subdivisión y el Displacement
Mapping, dispone de dos potentes herramientas
para crear de manera eficiente complejos personajes
que den el aspecto de estar construidos de arcilla
(véase la Figura 10.16) o de haber sido esculpidos
sobre metal (véase la Figura 10.17).Para crear una tex-
tura más fina, podría añadir un Bump Map además
del Displacement Map . Las protuberancias podrían
hacer el papel de pequeñas deformaciones dentro
de otras de más envergadura.

El proceso de modelado ha dejado nuestro perso-
naje con coordenadas de textura UV de distri-
bución muy desigual. Es lo que vería si hubiese
usado Normal en lugar de Projection como
método de asignación. Para solucionar estos
problemas de distribución de la textura, ten-
drá que crear un nuevo mapa de textura
UV, por ejemplo, aplicando el comando
Automatic Mapping, que encontrará
en el menú Subdiv Surfaces.

Una textura proyectada como la que
nos ocupa no plantea problemas relati-

vos a las coordenadas UV. Pero en cuanto
empezase a animar el personaje, ten-

dría que adaptar la textura proyectada a
la superficie. En caso contrario, daría la
impresión de que el personaje nadara

sobre la textura. Encontrará el
comando para adaptar textu-

ras en el Hypershader: eli-
ja Edit>Convert to File
Texture. Si desea usar
las sofisticadas herra-
mientas para la asigna-
ción de texturas poligo-
nales, guarde la escena y

convierta la criatura de subdivisión en una criatura poligonal (elija Mo-
dify>Convert>Subdiv to Polygons).

Figura 10.17
Personajes
esculpidos en metal.

▲
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Y ahora algo completamente
diferente:¿ha pulsado última-
mente las teclas A o F?

Figura 10.18 Personajes esculpidos
en oro.


